Your Presenter

· Jessica Muehlberg
· Senior Data Analyst, Student Information System
· University of Nevada, Reno
· jessicam@unr.edu
Overview

• We will cover the following:
  • Data Sources
    • Connected Query
  • Leveraging Variable Data
  • Communications
  • XML Reports
Introductions & Previous Experience

- Who has created their own communications using BI Publisher and CommGen?
- Who has created XML reports?
- Who has used connected query?
Agenda

• Build a Basic Data Source
• Basic Communication: Annual FERPA Notification
• Using Variable Data - SENR
• Advanced Communication: Purge for NoPay
• XML Report: Veteran’s Certification Report
• Using Connected Query
• XML Report: Orientation Advising Reports
What will not be covered...

• How to assign communications.
  • 3C Engine
  • Triggers
  • CommGen Process

• All of these are important but not the primary focus of this workshop.
University of Nevada

• Founded in 1874.
  • Land-Grant institution
  • Undergraduate, Graduate and Medical School
• Located in Northern Nevada, 45 minutes from Lake Tahoe.
• Mid-sized (18,500 students).
Oracle

- Campus Solutions 9.0 – Bundle 28
- PeopleTools 8.51
- Implemented Fall 2011 (starting Sept 2010)
What is BI Publisher?

• Simple version: An add-on for Microsoft Word that allows you to create templates to transform PS data to a more consumable (and prettier) format.

• When run, merges your data file (query) with the template to provide report.
Output Options

- PDF
- HTML
- RTF
- Microsoft Excel (HTML)
- XML
- Microsoft PowerPoint
Data Sources

- Can be created from queries or connected queries. Used to define what data elements are ‘available’ for your report.
Communication Data Sources

- Will provide the following generic data:
  - Name(s)
  - Addresses (physical and email)
- Can add custom data from a user defined PS Query
Data Sources

- Two different locations. One for XML reporting and one for communications.
- Communications
  - Campus Community > Communications > Set Up Communications > Communication Data Source
- Reports
  - Reporting Tools > XML Publisher > Data Source
Activity

BUILD A SIMPLE DATA SOURCE
Step One

• Identify any data elements you wish to include in your communication beyond student name
• Create a query pulling this data.
• Prompt on EMPLID (PERSON_ID)
Step Two: Create Data Source

Communication Data Source

Data Source Map ID: UNRER_GENERAL
Description: Basic Bio/Demo Only
Object Owner ID: Student Records
Data Source Type: XMLDoc Object

Data Source Context

*Administrative Function: GEN, General

Generic Process Data

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Description</th>
<th>Sample Data Folder Name</th>
<th>Critical Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List of Checklist Items</td>
<td>CHECKLIST_ITEMS</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>List of Enclosures</td>
<td>ENCLOSURES</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Address for a person</td>
<td>PER_ADDRESS</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>List of Person Communication Recipients</td>
<td>PER_COMM_RECV</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Email Address for Person</td>
<td>PER_EMAIL</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Name for individual address</td>
<td>PER_NAME_ADDR</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Name for extra use</td>
<td>PER_NAME_EXTRA</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Name for individual salutation</td>
<td>PER_NAME_SAL</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Name for joint salutation</td>
<td>PER_NAME_SALINT</td>
<td></td>
</tr>
</tbody>
</table>

Custom Extract Data

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Type</th>
<th>Query Name</th>
<th>Max Nbr</th>
<th>Application Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Query</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Step Three: Add additional query
Step 4: Register & Download Sample File

```
<table>
<thead>
<tr>
<th>Custom Extract Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Registered Date/Time: 07/13/11 13:52:38
Registered By: 1000347113

Last Update Date/Time: 07/13/11 13:52:39
Last Update User ID: 1000347113

View/Download Sample Data File
Register Data Source
```
Step 5: Update XML content if desired

<?xml version="1.0" encoding="UTF-8"?>
<rs_SCC_CG_HDR_VW xslnamespace="http://www.w3.org/2001/XMLSchema-instance" rowsetname="SCC_CG_HDR_VW" numrows="1">
  <fld_COMMON_ID>sample data</fld_COMMON_ID>
  <fld_SEN_SEQ>0</fld_SEN_SEQ>
  <fld_SEN_SEQ>0</fld_SEN_SEQ>
  <fld_LEDGER_CD>sample data</fld_LEDGER_CD>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
  <fld_Organization>sample data</fld_Organization>
Creating a RTF Template

- Basic Steps:
  1) Generate sample data.
  2) Load data to template builder.
  3) Create template.
  4) Upload template as Report Definition.
BI Publisher Add-On

• Download from Reporting Tools > XML Publisher > Setup > Design Helper

• IT staff need to make sure recent version

• Never recommend using the most recent

• Complaint: BI Publisher kills computers
Letter Tips

• Create a blank template for all your letters.
  • Header
  • Footer
  • Salutation

• NEVER save as a .DOC. Even if you change to .RTF later, still will not work.
Activity

CREATE A COMMUNICATION:
ANNUAL FERPA NOTIFICATION
Load Sample XML Data

1. In Word navigate to BI Publisher add-on.

2. Load your XML data file.
Insert Fields & Compose Comm

1. Select Insert > Field.
2. Position cursor as needed.
3. Double-click on field from dialogue box.
General Tips & Tricks

• Format fields using standard Word tools.
• Insert time/date fields using Word.
• Use preview.
• Don’t use signatures in emails.
• URL’s
  • Emails: Add a hyperlink to make letter look nice.
  • Hard copy: Cannot use hyperlinks. Override Word formatting unless you print in color.
Load Report Definition

• Report definitions tie the data source to a specific template.
• Set up output options.
• Reporting Tools > XML Publisher > Report Definition
Report Definition

Report Name: UNRCC_C01

Data Source
Data Source Type: XMLDoc Object
Data Source ID: UNRCC_GENERAL_DS
Data Source Description: CC General Data Source

Report Properties
Report Description: Annual FERPA Notification
*Report Status: Active
*Report Category ID: ALLUSER
Object Owner ID: Campus Community
*Template Type: RTF
Retention Days:
Registered Date/Time: 09/24/2012 16:10:33
Registered By: 1000347113
Updated Date/Time: 09/24/2012 16:10:34
Updated By: 1000347113
Download: Data Schema, Sample Data

Return to Search, Previous in List, Next in List, Add, Update/Display, Include History, Correct History
QUESTIONS?
Variable Data

- Allow for ‘smarter’ letters.
- Administrative Functions
- Cannot create or change delivered Variable Data setup without ‘significant programming effort’
Student Records Admin Functions

- GEN: No additional required fields
- STRM: Career and Term
- SPRG: Career and Career Number
- SENR: Career, Term, and Class Number
- Other research based
Using Var Data in Data Source

- Each query used in a data source must contain the required fields from the associated administrative function.
- Each field in the Var Data must be prompted in the query in addition to PERSON_ID.
Activity

CREATING A COMPLEX DATA SOURCE
Create Additional Query w/Prompts

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Edit</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>:1 = EMPID - PERSON_ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:2 = ACAD_CAREER - Career</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:3 = STRM - Term</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:4 = CLASS_NBR - Class Nbr</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Description: Enrollment Data Source
Add Query to Data Source

- **Description**: Enrollment
- **Object Owner ID**: Student Records
- **Data Source Type**: XMLDoc Object
- **Active**: Checked
- **Data Source Context**: Administrative Function - SENR: Student Enrollment

**Generic Process Data**

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Description</th>
<th>Sample Data Folder Name</th>
<th>Critical Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List of Checklist Items</td>
<td>CHECKLIST_ITEMS</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>List of Enclosures</td>
<td>ENCLOSURES</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Address for a person</td>
<td>PER_ADDRESS</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>List of Person Communication Recipients</td>
<td>PER_COMM_RECIP</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Email Address for Person</td>
<td>PER_EMAIL</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Name for individual address</td>
<td>PER_NAME_ADDR</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Name for extra use</td>
<td>PER_NAME_EXTRA</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Name for individual salutation</td>
<td>PER_NAME_SAL</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Name for joint salutation</td>
<td>PER_NAME_SALINT</td>
<td></td>
</tr>
</tbody>
</table>

**Custom Extract Data**

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Type</th>
<th>Query Name</th>
<th>Max Nbr</th>
<th>Application Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Query</td>
<td>UNRSRSDS_ENROLLMENT</td>
<td>99</td>
<td></td>
</tr>
</tbody>
</table>

- **Registered Date/Time**: 09/08/12 17:08:14
- **Registered By**: 1000347113
- **Last Update Date/Time**: 09/07/12 13:49:50
- **Last Update User ID**: 1000347113

View/Download Sample Data File
Note on Changing Data Sources

• You can always add new data/queries to existing data sources without messing up current letters/reports.

• If you remove fields however, you need to rebuild all communications/reports using that data source.
CREATE A COMMUNICATION: PURGE FOR NONPAYMENT
Purge Letter

Records & Registration
University of Nevada, Reno

3/16/2013

Dear fld_FIRST_NAME fld_LAST_NAME,

Please be advised that your enrollment in the following class has been cancelled:

<table>
<thead>
<tr>
<th>Subject</th>
<th>Catalog Number</th>
<th>Class Section</th>
<th>Class Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.SUBJECT</td>
<td>A.CATALOG_NBR</td>
<td>A.CLASS_SECTION</td>
<td>A.DESCRIPT</td>
</tr>
</tbody>
</table>

You have been assessed late fees and a financial hold has been placed on your account. You are not permitted further enrollment at any NSHE institution until this financial obligation is resolved.

Indianapolis, IN
March 17 – 20, 2013
XML Reports

- XML reports are built in a similar manner as communications but are not sent to students in CommGen.
- Use a data source and run through Query Report Viewer
Activity

BUILD SEMESTER VET CERTIFICATION REPORT
Build Query with All Necessary Information

Query Name: UNRSRDSS_VETSCERTREPORT
Description: SR DS: Vet Cert Report Basic D

Click folder next to record to show fields. Check fields to add to query. Uncheck fields to remove from query. Add additional records by clicking the records tab. When finished click the fields tab.

Chosen Records

<table>
<thead>
<tr>
<th>Alias</th>
<th>Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>UNR_PERSON_DATA - UNR Person Data</td>
</tr>
<tr>
<td>B</td>
<td>SCC_PERS_NI_QVW - Person National ID Query View left outer joined with A</td>
</tr>
<tr>
<td>C</td>
<td>SCC_PDE_USA_QVW - USA Person Ext Query View</td>
</tr>
<tr>
<td>D</td>
<td>UNRCPPFLSTK_QVW - UNR CPP Stack View</td>
</tr>
<tr>
<td>E</td>
<td>STDNT_CAR_TERM - Student Career Term Table</td>
</tr>
<tr>
<td>F</td>
<td>CLASS_TBL_SE_QVW - Class Table Student Enrl View</td>
</tr>
<tr>
<td>G</td>
<td>CLASS_TBL - Class Table</td>
</tr>
</tbody>
</table>

Expand All Records  Collapse All Records
Create Data Source

Data Source

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Add a New Value

*Search by: [Data Source ID] begins with

Search Advanced Search

Search Results

<table>
<thead>
<tr>
<th>Type</th>
<th>Data Source ID</th>
<th>Owner</th>
<th>Description</th>
<th>Owner ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Con. Query</td>
<td>UNRSRDS_CLASS_FEE_REPORT</td>
<td>Public</td>
<td>Term Class Fee Report</td>
<td>Student Records</td>
</tr>
<tr>
<td>Con. Query</td>
<td>UNRSRDS_ORIENTATION</td>
<td>Public</td>
<td>Orientation Data Sheets</td>
<td></td>
</tr>
<tr>
<td>PS Query</td>
<td>UNRSRDS_VETSCERTREPORT</td>
<td>Public</td>
<td>Vets Certification Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UNRSRDS_VETS_CERT_REPORT</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Build Report – Repeating Groups

![Image of a report page](image_url)

**Veterans Certification Report**
*As of: 3/16/2013*

#### UNR_PRI_NAME_DOC

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSHEID</td>
<td>EMPLID</td>
</tr>
<tr>
<td>SSN</td>
<td>NATIONAL_ID</td>
</tr>
<tr>
<td>Email</td>
<td>UNR_HOME_EMAIL</td>
</tr>
<tr>
<td>Military Status</td>
<td>MILITARY_STATUS</td>
</tr>
</tbody>
</table>

#### Career
- **ACAD_CAREER**
- **UNR_ACAD_PROG_DESC**
- **ACAD_PLAN_TYPE**
- **UNR_PLAN_DESC**
- **UNR_SUBPLODESC**
- **UNR_MULTI_ACT_MAJ**

#### Admit Term
- **ADMIT_TERM**
- **UNR_PROG_REQ_TRM**

#### Catalog Term
- **EXPECTED_GRAD_DATE**
- **DEGR_CHKOUT_STAT**

#### Semester Enrollment for Term STRM

<table>
<thead>
<tr>
<th>Subject</th>
<th>Catalog Number</th>
<th>Title</th>
<th>Units</th>
<th>Start Date</th>
<th>End Date</th>
<th>Instruction Mode</th>
<th>Grading Basis</th>
<th>Grade</th>
<th>Repeat Candidate</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATALO</td>
<td>DESCR</td>
<td>UNT_TAKE</td>
<td>START_DT</td>
<td>END_DT</td>
<td>INSTRUCTION</td>
<td>GRADING BASIS</td>
<td>CRSE_GRADE</td>
<td>REPEAT_CA</td>
<td></td>
</tr>
</tbody>
</table>

---

**ALLIANCE13**  
Indianapolis, IN  
March 17 – 20, 2013
Report Definition

Report Name: UNR_VETSCERT

Data Source
- Data Source Type: PS Query
- Data Source ID: UNRSRDS_VETSCERTREPORT
- Data Source Description: Vets Certification Report

Report Properties
- Report Description: Vets Certification Report
- *Report Status: Active
- *Report Category ID: ALLUSER
- Object Owner ID: PeopleTools
- *Template Type: RTF
- Retention Days: 
- Registered Date/Time: 05/13/2012 10:28:25PM
- Registered By: 1000347113
- Updated Date/Time: 05/13/2012 10:28:25PM
- Updated By: 1000347113

Download:
- Data Schema
- Sample Data

Options:
- Return to Search
- Previous in List
- Next in List
- Add
- Update/Display
- Include History
- Correct History
Query Report Viewer

Enter any information you have and click Search. Leave fields blank for a list of all values.

*Search by: Report Name begins with UNR_V

Search Results

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Data Source ID</th>
<th>*Format</th>
<th>Burst</th>
<th>View Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNR_VETSCERT</td>
<td>Vets Certification Report</td>
<td>UNRSRDS_VETSCERTREPORT</td>
<td>PDF</td>
<td>N</td>
<td>View Report</td>
</tr>
</tbody>
</table>

Show Template Prompts
QUESTIONS?
Connected Query

• Allows multiple repeating groups without the ‘multiplying data rows’ issue.

• HOWEVER, can only be run in scheduled batch process.
Activity

BUILD A CONNECTED QUERY AND DATA SOURCE
Build Connected Query

Connected Query Manager

Connected Query: UNRSRDS_ORIENTATION

- Public
- Status: Active

Description: Orientation Advising Sheets

Parent Query Selection

Parent Query: UNRSRDS_ORNT_BASIC

Connected Query Structure

- UNRSRDS_ORNT_BASIC
  - UNRSRDS_ORNT_CPP
  - UNRSRDS_ORNT_ENRL
  - UNRSRDS_ORNT_APTST
  - UNRSRDS_ORNT_SG
  - UNRSRDS_ORNT_SI
  - UNRSRDS_ORNT_TEST
Create Data Source

Data Source

Data Source Type: Connected Query
Data Source ID: UNRSRDS_ORIENTATION

Data Source Properties

Description: Orientation Data Sheets
Object Owner ID: Student Records
Registered Date/Time: 06/18/12 6:51:53PM
Registered By: 1000347113
Last Update Date/Time: 03/16/13 7:50:39PM
Updated By: 1000347113

Related Files

<table>
<thead>
<tr>
<th>File Type</th>
<th>File</th>
<th>Generate File</th>
<th>Or</th>
<th>Upload File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Data File</td>
<td>UNRSRDS_ORIENTATION.XML</td>
<td>Regenerate</td>
<td>Or</td>
<td>Upload</td>
</tr>
</tbody>
</table>

Return to Search  Previous in List  Next in List
Add  Update/Display
Orientation Advising Sheet

Orientation Advising Sheets
University of Nevada, Reno

B.UNR_PRI_NAME

Fall Load: C.ACADEMIC_LOAD
Academic Level: C.ACAD_LEVEL_BOT

Enrollment GPA: C.SSR_CUM_EN_GPA
Cumulative GPA (including transfer work): C.CUM_GPA
Primary Program: C.ACAD_PROG_PRIMARY

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Plan Code</th>
<th>Subplan Code</th>
<th>Plan Description</th>
<th>Catalog Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>B.ACAD_PLAN</td>
<td>C.ACAD_SUB_PLAN</td>
<td>D.DESCR</td>
<td>A.REQ_TERM</td>
</tr>
<tr>
<td>D.ACAD_PLAN</td>
<td>N_TYPE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject	| Catalog Number | Section | Description | Component | Units |
|---------|---------------|---------|-------------|-----------|-------|

NSHEID: B.EMPLID

Fall Total Units: C.UNT_TAKEN_PRGRSS
Total Transfer Units: C.SSR_TOT_TR_TKNGPA
Query Report Scheduler

Run Control ID: UNRSLR_ORIENTATION
Language: English

Report Definition
Data Source Type: Connected Query
Report Name: UNRSLR_ORIENTATION
Template ID: UNRSLR_ORIENTATION_1
Template As Of Date:

Query Parameters
<table>
<thead>
<tr>
<th>Query Name</th>
<th>Prompt Name</th>
<th>Prompt Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNRSLRSDS_ORNT_BASIC</td>
<td>STRM</td>
<td>2132</td>
</tr>
</tbody>
</table>

Go to XMLP Report Search

Process Monitor Run
Process Instance: 522913

ALLIANCE 13
Indianapolis, IN
March 17 – 20, 2013
QUESTIONS?
THANK YOU!

jessicam@unr.edu
This presentation and all Alliance 2013 presentations are available for download from the HEUG conference site.

www.alliance-conference.com